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About This Particular Macintosh has been free since 1995, and we intend to keep it that
way. Our editors and staff are volunteers with “real” jobs who believe in the Macintosh
way of computing. We don’t make a profit, nor do we plan to. As such, we rely on
advertisers and readers like you to help us pay for our Web site and other expenses.
We’ve partnered with CafePress.com to bring you high-quality ATPM merchandise. For
each item you buy, $1 goes towards keeping the atpm.com server running. You can also
help support ATPM by buying from online retailers using our links. If you’re going to buy
from them anyway, why not help us at the same time?
We also accept direct contributions using PayPal and Amazon’s Honor System. We suggest
$10 for students and $20 for individuals, but we greatly appreciate contributions of any
size.
Finally, we are accepting inquiries from interested sponsors and advertisers. We have a
variety of programs available to tailor to your needs. Please contact us at
advertise@atpm.com for more information.
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Welcome

Welcome
by Robert Paul Leitao, rleitao@atpm.com

Welcome to the May issue of About This Particular Macintosh! Apple has done it again!
What you ask? The new iTunes music service? Yes. But more on the new music service a
bit later. We’re talking about releasing new products at the end of the month and on the
same day as our publication deadline. Let’s call this the most timely May issue in ATPM
history!

© Grant Osborne

iTunes, iPods, and International Ire
That’s right. On April 28th Apple announced the iTunes Music Store. The stores requires a
half dozen or so things:
1. A Mac with Mac OS X 10.1.5 or later
ATPM 9.05
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2. A credit card
3. iTunes 4
4. QuickTime 6.2 (recommended)
5. Broadband Internet access
6. Residency in the USA
OK, really only five things. But try the new service on dialup at your own risk. The 30second song demos on dialup take about 20 minutes to play (not really that long, but they
do take awhile). For the lucky millions who do have the recommended equipment and
meet the all-important residency requirement, there are now 200,000 songs available for
download at a cost of only $.99 each.
Of course many of the most vocal Mac users to comment on the service (or lack thereof)
live overseas where the iTunes Music Store has yet to open its digital doors. This has raised
the ire of Apple’s international user community more quickly than US users can download
a couple dollars’ worth of songs.
Accompanying the new music service are new iPods boasting larger drives, smaller forms,
and better buttons. The new 30 GB iPod can hold up to 7,500 songs. For the penultimate
Mac user digital music experience the cost is only $7,924 ($7,425 for 7,500 songs at $.99
each and $499.00 for the 30 GB iPod). Most users might get by with a less expensive iPod
and perhaps a few thousand fewer songs in AAC format. For people not familiar with the
new AAC format, it’s richer than MP3, provides for easier anti-piracy protection, and gives
a new reason for people to buy a Mac for their music pleasure. At least that’s Apple’s plan;
let’s see how consumers respond.

Bottom Line It, Baby
At $.99 per song (Apple will reportedly keep on average $.34 from each song purchase
with the balance remitted to the music labels), it will take millions of song downloads for
the new music service to appreciably impact Apple’s earnings. It’s still hardware sales that
drive Apple’s revenue.
In April Apple announced a net profit of $.04 per share for the three months ended March
29, 2003. Apple’s second fiscal quarter is traditionally the company’s weakest for sales and
earnings. During the quarter Apple shipped 711,000 Macintosh units of which more than
40% of were laptops. Due to late shipments of the new 17" PowerBooks, Apple ended
the quarter with about 4.5 weeks of channel inventory. Apple’s channel inventory level is
ATPM 9.05
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among the lowest in the PC industry. This was good news for Apple but a lesson in
patience for buyers waiting on delivery of what some call the “TowerBook” because of its
size.
Apple ended the quarter with more than $4.5 billion in cash and equivalents. Despite the
somewhat tepid earnings report, Apple has increased its cash holding by about $190
million since the beginning of the fiscal year. Apple ended yet another quarter with big
cash, small market share, and an anxious Mac community speculating about even more
products to come. This might lead a Mac user to say…

So What Else is New?
We’re glad you asked! Final Cut Pro 4 will soon be released, and the ubiquitous iBook
received a speed bump and larger hard drive. For digital artists and engineers, the
forthcoming Shake 3 has new features and unlimited licenses for distributing work over
multiple Macs. For those of us with only $.99 songs available for purchase with our limited
technology budgets, Safari Public Beta 2 is available for free download on the Apple site
and via Mac OS X’s software update service. There’s more news and information about
Mac-related products inside this issue.

Our May issue includes:

The Candy Apple: This Month’s Candy Apple Is Golden (the Golden Rule,
That Is)
Ellyn explains why we should pay for what we use.

Report: National Association of Broadcasters Convention 2003
Lee Bennett gets indoctrinated to the NAB experience and describes what it was like.
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Interview: Jonathan Gales
Lee Bennett sits down to chat with Jonathan Gales about his latest endeavor:
MobileTracker.net.

What’s Under The Hood: Got Vinyl? Converting LPs to CDs—Part 3
Robert C. Lewis concludes his series on converting LPs to CDs by discussing how to split
recordings into tracks and then burn them to CD.

How To: Mac OS X’s Acrobatic Moves
New ATPM writer Matthew Coates likes PDFs. He discusses the Acrobat-like features built
into Mac OS X and then shows how to use Adobe’s Web site to create PDFs from many
different types of files. You don’t have to buy Distiller!

Cartoon: Cortland
This month’s Cortland pokes fun at consultants. Who do they really serve?

Desktop Pictures: Flowers—Part 3
Jens Grabenstein travelled to California and brought back some pictures of flowers.

Review: Google Hacks (book)
If you’re seeking information about the Web’s best search engine, look no further. Kirk
McElhearn reviews Google Hacks, a great book whose 300+ pages will tell you everything
you ever needed to know about using and programming the site.

Review: Pocket Tanks 1.00b
Fans of Scorched Earth will be interested in reading about Pocket Tanks, reviewed in this
issue by Daniel Boland. Pick your weapons and start fighting.

Review: SPSS 11.0
If you’re in need of a heavy-duty statistical analysis program, we’ve got one for you: David
A. Zatz reviews the latest version of SPSS, a Mac OS X-only port of the program.
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Review: Ten Thumbs Typing Tutor 2.2.2
Knowing how to type is pretty much a necessity, and Ten Thumbs Typing Tutor is one way
to learn, offering a way to practice your most troublesome keys, and a few games to
reinforce what you’ve learned. Reviewer Gregory Tetrault also suggests several alternative
programs to consider.

Review: TiVo Home Media Option
TiVo has been popular for a long time, but you may not know about the TiVo Home
Media Option. Eric Blair introduces you to a way to link your Mac and your TiVo together,
allowing basic sharing of music and photos between the two platforms.

Review: World War 2 Online Blitzkrieg
Joe Kudrna reviews World War 2 Online Blitzkrieg, a highly detailed online combat
simulation game that “spawns” you into WW2. Teamwork is highly important: unlike
many shoot ’em up style games, this game doesn’t expect you to win the war alone.
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E-Mail
Back Issues
I just received my first online edition of ATPM; thank you for the best publication of its
type I’ve ever seen.
How can I retrieve previous issues of ATPM?
—Charles G. Lynch
All the back issues are available on our Web site. —Michael Tsai

Mac OS X
A couple of months ago, feeling desperate, I sent an e-mail to ATPM explaining how, at
82 years, I was appalled to be confronted by Mac OS X; that I didn’t know how to use it or
to learn it especially as I was suffering from loss of memory. Step forward the readers of
ATPM. John Petty, Matthew Coates, and Jack Schachtebeck all offered help, and I don’t
mind confessing that I used them shamelessly. But each one helped me to solve a puzzle
or two. Now I’m feeling much happier with the new system and beginning to have a
suspicion that it’s better than OS9. Thank you ATPM.
—Marius Pope

Kudos
Hi there. I stumbled across your site while looking for FireWire info about my new (for me)
Power Mac G3/300. It’s a pleasure to find such a clean and well-run site with clear,
concise, and helpful, to-the-point articles. Thanks again.
—Richard Woodruff
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Converting LPs to CDs
Using an old turntable, a pre-amp, and an iMic, in addition to LP signals I receive a radio
broadcast. Has anyone encountered this? Could a new, good turntable be the answer?
Any ideas? Much thanks for any help.
—Robert Frye
•••
Usually the phono pre-amp has a Radio Frequency (RF) filter to block the FM.
I just contacted a radio engineer friend and here’s his help to find where the RF is leaking
in. At each step, listen for the RF to go away.
1. All devices need to be grounded to the same power plug. If they’re plugged into the
same wall outlet with a power bar, that will do it.
2. Connect everything up and listen for the RF.
3. Disconnect the turntable from the pre-amp.
4. Connect a cable to the pre-amp to mimic the turntable cables. If you hear RF, then you
may have bad turntable cables. This is where your problem is.
5. Disconnect the pre-amp from the iMic. If you hear RF here, you have a bad RF filter in
the pre-amp. This is the most likely the source—a pre-amp with a cheap RF filter.
6. Disconnect the iMic (highly unlikely since this is an analogue problem). If you hear RF,
you’ve got bad sockets on the iMic, I guess.
In each step, disconnect and reconnect a few times to be sure you are hearing the RF.
Hope this helps.
—Brian L. Reimer
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•••
I believe I have determined that the Radio Shack pre-amp I was using leaks. I have located
a better one. As far as I can tell, the radio signal is gone. Should it fail, I still have the other
tests you said to try. Meanwhile, I want to thank you and your engineer friend for your
outstanding assistance. It’s spared me further anguish and the cost of a new turntable.
Please know that it is greatly appreciated.
—Robert Frye

Virtual PC
I can’t seem to get Internet Explorer in Virtual PC 2.1.2 to work with the internal modem
in my iBook. Could you please tell me how to get this to work?
—Jobby Wan Kenobi
I am assuming that you have an older iBook and are running OS 9. Upgrading to a newer version of VPC
makes it easier to connect to the Internet (because VPC will share your Mac connection), but it isn’t required.
The trick is to create two different TCP/IP connection sets (TCP/IP, Modem, and AppleTalk settings) for your
iBook. One set is for connecting to the Internet via OS 9, the other for VPC 2.1. I used Location Manager to
make switching back and forth easier. I do not remember all the details on how to do this, but they are
described in the VPC manual. If I recall correctly, you will need to set AppleTalk to “remote only.” You also
will have to properly configure your network, modem, and Internet settings in Windows to work with your
iBook’s internal modem. —Gregory Tetrault
Copyright © 2003 the ATPM Staff, editor@atpm.com. We’d love to hear your thoughts about our
publication. We always welcome your comments, criticisms, suggestions, and praise. Or, if you
have an opinion or announcement about the Macintosh platform in general, that’s OK too. Send
your e-mail to editor@atpm.com. All mail becomes the property of ATPM.
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Candy Apple: The Golden Rule

The Candy Apple
by Ellyn Ritterskamp, eritterskamp@atpm.com

This Month’s Candy Apple Is Golden (the Golden Rule,
That Is)
I just wrapped up a unit on ethics with an introductory philosophy class and thought some
of the stuff we learned might be applicable to the rest of us. We often face decisions
about how to participate in a technological society; maybe some of these ideas will help
simplify those choices. We’ll talk about the ideas first, then try some sample problems.
Idea 1—Behave toward other people in ways you believe they should behave toward you.
It doesn’t matter what we think or feel, as long as our actions are grounded in respect for
others. If we behave well toward others, eventually the thoughts and feelings of
benevolence follow. Maybe. But that almost doesn’t matter. What really matters is that we
don’t harm others.
Idea 2—Behave so as to maximize happiness for everyone. This one is difficult to quantify,
but certain actions are recognized as being generally contributory to many people’s
happiness. The definition of “happiness” here is not giddiness or ecstasy, just a general
feeling of well-being that lasts and is not constantly under attack.
Idea 3—Behave properly out of a state of character that makes it obvious what you should
do.
Idea 1 is duty ethics, Idea 2 is utilitarianism, and Idea 3 is virtue ethics. Grossly
oversimplified, all of them, but clear enough for our purpose, which is to apply them to
real-life choices many of us make or have already made.
Problem 1—Whether to download an MP3 from someone else’s computer. The issue is
whether the music is copyrighted and ought to be paid for rather than shared. This does
not include instances in which explicit permission is given to copy a file. If an artist is losing
money by my copying the file rather than purchasing it, then the artist is being harmed.
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Using duty ethics, we ask, “Would it be OK if I were trying to sell music and people didn’t
pay for it but instead copied it for each other?” If the answer is No, then we will commit
an unethical act if we download the file.
Using the principle of utility (utilitarianism), we ask, “Is it good for society for me to copy
this file without paying for it?” If the answer is No, because it introduces an erosion of
trust that will reduce future good for the society, then we commit an unethical act when
we download the file.
Using virtue ethics, we never have to ask the question. We spend a lifetime cultivating a
virtuous state of soul. If the virtues of courage, justice, moderation, and wisdom are
sufficiently nurtured, when we arrive at moments of choice, we know what to do. We
have a sense of what is just, and how that means that things belong in their proper places.
We are sufficiently savvy in the subtleties of when to make exceptions and under what
circumstances. We are courageous about doing the right thing even if it is not easy
(especially when it is not easy!). We temper our desires with the knowledge that we are
doing the right thing.
Problem 2—Whether to send in the shareware fee on an application. If the creator is not
properly rewarded for her hard work and ideas, then we harm her. A reasonable trial
period is understood as part of the demonstration. My hypothetical problem is concerned
with what happens once that trial period has resulted in a decision to keep the software.
Using duty ethics, we ask, “Would it be OK if I were trying to make a living by making my
program inexpensively available on the honor system, and nobody sent in the 10 bucks?”
If the answer is No, then we will commit an unethical act if we use the program without
paying for it.
Using the principle of utility (utilitarianism), we ask, “Is it good for society for me to
continue using this program without paying for it?” If the answer is No, because it means
that eventually shareware writers and artists will stop producing their work because they
are not being fairly compensated for it, then we commit an unethical act when we use the
program without paying for it.
Using virtue ethics, just like on Problem 1, we never have to ask the question. We are such
great people that we know what to do. We test the software for a while, decide we want
to keep it, and then we send in the money. Easy.
ATPM 9.05
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•••
So there you have it. Three different ways to tackle life’s toughest ethical problems. And all
you have to do is decide whether to download some tunes, or whether to fork over that
$10 you’ve been meaning to send in for that nifty piece of software you use every other
day.
Onward.
Copyright © 2003 Ellyn Ritterskamp, eritterskamp@atpm.com.
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Report: NAB 2003

Report
by Lee Bennett, lbennett@atpm.com

National Association of Broadcasters Convention 2003
Can You Say “Newbie?”
Let’s be totally truthful. What you’ve got here is a first-time NAB attendee who has only
started doing digital video (DV) work in the past two years or so and is just finally
beginning to learn to use Apple’s Final Cut Pro instead of Adobe Premiere. But since it
seems I’m the only ATPM staff member who went, I was nominated to come back with
the scoop! Luckily, I had an NAB veteran with me. My good friend and former college
roommate, Andy McConnell, took me under his wing and helped me to have a really
good time. Andy has attended eight of the last nine NAB conventions.
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I could easily go on about what it felt like to be one of about 90,000 people wandering
around the two-million-square-foot Las Vegas Convention Center that housed some
1,200 exhibitors. However, since this publication is about the Macintosh experience, I’ll
stay focused.

The spectators around Apple’s pavilion at NAB were never sparse.
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Apple’s Video Editing Powerhouse
Probably the biggest announcement pertaining to Macintosh users was the
announcement of Final Cut Pro 4 to be released between June and August. I think the
only complaint I have is self-imposed. I’ll be editing several short videos to be shown at an
annual week-long convocation that always begins on Memorial Day weekend, and it just
seems too bad I won’t quite be able to use the new version for this round of videos.

Apple announced Final Cut Pro 4 on Sunday, April 6. These
banners were hung outside the South Hall shortly afterward.

The new Final Cut Pro 4 features were met with enthusiastic applause at each moment
and venue I heard them. The new features total more than 300—the most significant
being RT Extreme, support for 8- and 10-bit uncompressed video, 32-bit processing, and
enhanced interface customization.

Bundles of Joy
Final Cut Pro 4 will also come bundled with three brand-new applications. LiveType
provides powerful animation tools to your titling, including templates to make letters
appear to digitally draw themselves on the screen. Compressor incorporates media
encoding directly within Final Cut Pro. The first time I heard Compressor being mentioned,
ATPM 9.05
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I overheard someone in the crowd say, “Bye bye, Cleaner!” Last, but absolutely not least,
is Soundtrack, an integrated application providing access to thousands of royalty-free
music samples and 30 professional effects. All the sounds loop and automatically match
each other in adjustable pitch and tempo, allowing you to “compose” an infinite number
of musical arrangements for your videos. If this sounds familiar to composing with Sonic
Foundry’s Acid on the PC, it may be no wonder. While I have not been able to find a solid
source for this fact, my understanding is that one of the people Apple recruited to develop
Soundtrack also helped write Acid.

…And That’s Not All…
In addition to these new applications, Cinema Tools—previously available separately—will
also be bundled with Final Cut Pro 4. The utility, which originally sold for nearly $1,000,
has been updated to support ink numbers and change lists for both 35mm and 16mm
film.
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Final Cut Pro 4’s price for a new purchase will remain unchanged at $999. Upgrades are
$399.

Yours truly sat in on a 30-minute introduction to Final Cut Pro 4.
Apple set up a mini classroom within their pavilion and conducted
these introductions—as well as several in-depth topic-specific
tutorials—all day long throughout the convention. 20–30
workstations were set up, complete with Bose QuietComfort(R)
Acoustic Noise Cancelling(R) headsets. Getting to try out these
headphones for a half hour clinched my decision to buy a set the
next day!
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It’s Not Over ’til Apple Says It’s Over
Apple also announced Shake 3 and DVD Studio Pro 2 at NAB. Shake is a digital
compositing and visual effects package for use with HD and film projects and uses Shake
Qmaster network render management software. DVD Studio Pro 2 brings an updated
interface, time line track editing, and professional templates, styles, buttons, and
backgrounds.

Your new production team is here.

Can You Say “Growing Market Share?”
Andy informed me that, for a while, Apple’s presence at NAB seemed to be dwindling.
That is absolutely not the case any longer. Practically every time I turned to a new
exhibitor, I saw Apple equipment driving what they had to show. Numerous exhibitors had
even gotten their hands on the new 17" PowerBook.
I spent a little too much energy just taking everything in and not getting as many
photographs as I should have. Not to worry, though. Apple reps took care of that job for
me. Apple’s Web site has a full section devoted to NAB 2003, complete with photo
galleries.

Award-winning Wonders
One additional bit of major news for Apple is that Final Cut Pro 4 won two best of show
awards. MacCentral reports that FCP was the recipient of a Vidy Award and a
Government Video Salute, presented by United Entertainment Media.
ATPM 9.05
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Final Thought
I’m going to wrap up with props to Crywolf and whoever came up with the slogan for
their CoolMac Silencer. The slogan, “Hear Yourself Think Different,” is something we can
all take to heart. Granted, it’s for a product that I’ll probably never directly use any time
soon, but the words left a considerable impression—especially when you consider the
numerous complaints at how loud the Mirrored Drive Door G4s are. This company makes
some great-looking equipment silencing and cooling cases. Some marketing brain was on
the ball with this slogan.
But beyond this product, think about the slogan. How much psychological clutter is
present in your life that prevents you from being able to, well, think different?
Anyway, I hope to see you at NAB 2004!
Copyright © 2003 Lee Bennett, lbennett@atpm.com.
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Interview: Jonathan Gales

Interview
by Lee Bennett, lbennett@atpm.com

Jonathan Gales, MobileTracker.net
Advances in mobile communication technology lately have picked up such a pace, one can
hardly stay abreast of what is current—that is, until MobileTracker.net came along. ATPM
decided to dig into the mind of MobileTracker’s kingpin, Jonathan Gales.
During one of my numerous weekend trips to Tampa, Florida, I met up with Jon at the
Apple Store at International Plaza. We spent a few moments drooling over the current line
of PowerBooks, then made our way to the outdoor portion of the mall, sat down, and
started to talk about MobileTracker.
•••
ATPM: Start by telling us what you currently do. You’re in school, right?
Jonathan Gales: Shhh. You aren’t supposed to know I’m in school! But, if you must
know, in a few years I will be a degree-carrying computer scientist. Currently, my time is
divided among MacMerc, MobileTracker, and school.
ATPM: What did you do that first got you into Web programming?
JG: I started out about six years ago learning HTML through GeoCities. It was about the
only thing back then and, at that time, it didn’t have any fancy templating. Just HTML,
baby.
ATPM: At what point did you start learning the level of HTML and PHP you program in
today?
JG: I got a book on Perl a few years back and then quickly moved on to PHP because CGI
just plain sucks. I got a few books on the subject, but what helped the most was PHP.net
(the best site for a programming language, ever). I quickly learned a few things and then
started writing stuff for other people.
ATPM 9.05
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ATPM: Before MobileTracker, MacMerc was where much of your online time was spent.
What is your role there and how did you get involved?
JG: I’m technically the “Webmaster,” but most of my time is spent writing articles and
news—not code. Rick Yaeger, the founder, started the site probably close to four years
ago and asked me to come on board in June 2001. We took the site from a Blogger.compowered weeny to a PHP/MySQL powerhouse. It was a big transition, but it’s been fun.
Along the way, we’ve picked up a few other people—Greg Maddux and Brian Burnham.
ATPM: And then, after a time of working with MacMerc and your blog, you started
MobileTracker. Tell us exactly what MobileTracker is all about and your motivation for
starting it.
JG: I love Gizmodo, but it doesn’t cover much of the phone market—it’s all about
gadgets. I figured I could scoop him on most stories and just cover the market much
better. I also thought the economics would pay off and, so far, they have. MobileTracker is
the relaunch of n3rd.net Cell Station—a site that lasted about two weeks. I thought it was
great, but then the editor over at MacMinute said, “Hey, you need a domain name.” It
never crossed my mind before, but I instantly felt the need. In about 10 minutes, I had the
debit card out and owned MobileTracker.net. The site’s purpose is simply to track the latest
and greatest in the mobile world. MobileTracker is never pushy about buying anything,
but when someone does, we get a kickback. Not big, usually 15 percent, but it keeps the
server running. As the site grows, economies of scale start to kick in.
ATPM: And the site’s tag line is dead on. You can’t trust the salesperson! Do you report on
all things in mobile communications or is there a niche that you tend to focus on?
JG: MobileTracker definitely focuses on cell phones, but since the market changes so fast,
who knows what’s going to be next? Gotta keep the future open.
ATPM: Do you have access to particular sources or any insider information about
upcoming technology, or do you simply report on what you find on your own?
JG: Can I plead the fifth? We go into rumors as much as possible, but our sources aren’t,
at this time, mission critical. However, if anyone wants to be a snoop, they can e-mail us.
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ATPM: Hah, yeah, you’re allowed to plead the fifth! So what are some of the coolest and
most innovative things you’ve reported on to date?
JG: I’d say the satellite-powered phones that are being used all over Iraq by essentially
every cable news station. They are actually quite cheap and readily available. Some of the
other cool stuff in the news is video recording on phones (MPEG-4) and the color HipTop
that’s coming this fall.
ATPM: MobileTracker’s coverage includes combination PDA/phone devices. Is there any
other type of related technology you’d like to include as part of MobileTracker someday?
JG: The PowerPage does a great job with some of the other mobile technology (laptops,
for instance). The goal is really to just focus on phones. It’s a big market, and the site can
always do even better than it is right now (everyone can always improve).
ATPM: We were just looking at the latest version of PowerBook G4s at the Apple Store
before doing this interview. I suppose you’re itching to buy one pretty soon?
JG: Totally. I use Macs exclusively and, since I update a few sites daily, I spend a lot of time
on my aging 400 MHz G4 tower. As I mentioned, I go to school and, in between classes, it
would be great to be able to bypass the computer lab and hop online in style. I have
PowerBook envy so bad, it hurts.
ATPM: Should I be worried that you’re typing on my PowerBook with your responses?
(smirk)
JG: Um (scouts out escape path), no, not at all…
ATPM: I’m suddenly reminded of the Lay’s potato chips commercial. Get your own
PowerBook! Anyway, how do Macs figure into MobileTracker and your own life?
JG: MobileTracker isn’t a Mac site but, because most Mac users like nice things, a good bit
of our traffic is Mac users. Also, most of my contacts are at Mac sites thanks to my stint at
MacMerc, so when I beg for the almighty link, it’s usually on a Mac site (it’s no coincidence
we’re doing this interview). I use a Mac because I’m not an IT guy. When I’m working on
something, I want the computer to be a tool to accomplish the task—not just a tool.
Windows-powered computers just don’t do this.
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ATPM: Is there anything else about MobileTracker you want potential visitors to know?
What can a newcomer expect when he clicks to MobileTracker.net?
JG: We update all the time Monday through Friday and as warranted on the weekends. If
you don’t want to be a compulsive clicker, subscribe to our RSS feed. It includes full posts
and pictures. If it’s your first time at MobileTracker, take some time to look around and,
hopefully, you’ll like what you see. Also, if you have a lead on a hot news story that hasn’t
yet been featured, let us know—news@mobiletracker.net.
ATPM: Thanks, Jon. It was totally my pleasure to meet you in person and I wish you
success with MobileTracker.
Copyright © 2003 Lee Bennett, lbennett@atpm.com.
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What’s Under the Hood
by Robert C. Lewis, rlewis@atpm.com

Got Vinyl? LPs to CDs Part 3: The Playlist and Burning to
CD
The Story So Far
In the first part of this series I discussed the relevant terminology and went over the
required hardware. Last month, I looked at how to record and how to filter your
recording.
When you copied your original recording onto your Mac and filtered it to your liking, you
did it as one continuous piece of audio. In this form, there is nothing separating each song
or track; if you were to burn your music to CD at this point, you would not be able to
switch between individual tracks at will. The next step, therefore, is to break your music
into individual tracks. This article, the last in the series, will show how to break up your
recording into individual tracks, arrange those tracks into a playlist, and burn that playlist
to CD.

Amadeus II
Doing this in Amadeus II is straightforward. Highlight the first song in your recording.
Make sure you check the beginning and end of your selection so you don’t clip either end
of the song. From the Edit menu, select Copy, and from the File menu, select New. You
will then be presented with a new sound window. Select Paste from the Edit menu and
that track will be pasted into the sound window. To be on the safe side, play back both
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the beginning and end of this track. If the music starts or ends abruptly, discard the new
file and re-try selecting the track in your original recording, copying and pasting it into a
new file.

Amadeus II: Copying a Track

You might also want to play back the track in its entirety to make sure all unwanted noise
has been eliminated. If not, go back to part two of this series and apply the various filters
as I described. Once you are satisfied with that track, choose Save As… from the File
menu, name the file, and click Save. Then, go back to your original recording and repeat
this process with each of the rest of the tracks. I suggest that you save all of your tracks in
a new folder.
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Final Vinyl
Last month, I reported that Final Vinyl (which, as you will recall, comes bundled with
Griffin Technology’s iMic) lacked the filters required to restore your recordings. Sadly, I
have also found it to be weak when it comes to cutting your music into tracks. Although
the instructions did explain how to place “cue marks” between each cut, they did not
explain how to save each track.

Final Vinyl: Adding a Cue Mark

The instructions tell you that for each break between two songs found while playing back
your recording, you should select Pause from the Control window and then click on
“Cue+” in the Control window. This will then put a marker between the two tracks. At
this point, the instructions leave you hanging on what to do next. I tried to save, thinking
it might save the tracks individually, to no avail.
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Worse, Final Vinyl saves its audio files without type and creator codes. The type code must
be set to AIFF (all caps) so that other editing applications can read them. There are many
utilities available that let you change a file’s type and creator codes, one example being
Super Get Info, but that is beyond the scope of this article.
I could go on about Final Vinyl’s weaknesses, but there are alternatives to Final Vinyl. I
have already tested the iMic with Amadeus II, Peak LE, Spin Doctor, and Montage. Of
these four, Amadeus II and Peak LE worked with the iMic because they support Apple’s
Sound Manager, for which the iMic acts as an input source.
There may be other audio software available that is also compatible with the iMic; if you
know of such software, please let me know by e-mail and I will try to compile a list for
next month’s column. If you plan to use the iMic, I recommend that you use Amadeus II to
record and edit your music; I don’t think it’s worth using Final Vinyl, even though it’s free.
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Peak LE
Separating recordings into individual tracks works very well in Peak LE, and it is done by
breaking your music into regions. A region is a segment of audio bounded by markers that
signify the start and end.

Peak LE: Marking the End of Track One

To create a region, click at the beginning of a song. Then find the end of the cut and Shiftclick there to highlight that song. From the Action menu, select New Region. A dialog box
will appear asking you to name that section of music. Choose a name, click OK, and that
section will automatically be marked off as a region, with start and end markers
designated by two yellow lines.
The thing I like most about this method is the fact that these lines are not set in stone. If
you listen to the end of the region and find it cuts off prematurely, you can click on the
region marker and move it to the correct position. Once you have created your first region,
repeat the process for the other songs in your recording.
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After you have separated your recording into regions, you will be ready to create your
playlist from within Peak LE. In the File menu, select New > Playlist and a blank Playlist
window will appear. Next, go to the Window menu and select Contents. This will open a
content window that displays all of the regions you marked off in your recording. Now all
you have to do is drag your titles over to the Playlist window. If they are not in the right
order, simply drag a title to another position.
Once you have the playlist the way you like it, go to the File menu, select Save As…, and
give your playlist a name. Then you are ready to burn to CD. Peak LE is designed to work
with Toast 5 and higher, and a copy of Toast Light is bundled accordingly.
At the top of the playlist window is a set of buttons. On the left side next to the trash can
you will see a button with a small icon of a CD and a letter B within it. Click it, and Peak LE
will automatically launch Toast and copy the playlist over. Unfortunately, the track titles do
not carry over. You will have to rename the tracks in Toast by double-clicking on each title
and retyping its correct name.

CD Spin Doctor
There are three different ways to separate your recording into tracks using CD Spin Doctor.
Auto-Define Tracks (ADT), found in the Tracks menu, will automatically go through your
recording looking for points of silence. Each time it finds such a point, it places a marker
there.
The problem with this method is that if there is a false ending or sudden drop in sound,
ADT will place a marker there causing one track to become two or even three tracks. ADT
does an even worse job with classical music, and removing unneeded tracks can become
very tedious especially when eight tracks become 20, or more. Roxio recommends that
you only use this function when you are sure that all tracks in a recording are continuous,
with no false audio drops.
The Define Track function, also in the Tracks menu, works in almost the same way as the
New Region command does in Peak LE. Before you start this process, expand the window
to fill your screen; this will help you find the gaps between each track with more ease. For
some reason the zoom button at the top left of the window is grayed out, so use the drag
handle on the bottom right corner instead.
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Now, find the beginning of the first track. Click where the music begins and drag to the
right, keeping your eye open to when that track ends. Once you find that point, let go.
That section will be highlighted. Select Define Track from the Track menu; that track will
now have markers set at the beginning and end of it and a generic title will appear in the
Playlist window. Repeat this process for your other tracks.
A mistake in the start or end time of a track can also be easily corrected. Select the track
you wish to modify from the playlist to highlight it. Go to where you wish to make the
correction. Shift-click in the blue area next to the marker and drag in the direction needed
to correct the mistake. As you drag, the area you move over will turn white. Once done,
release the mouse, and the marker will move to the new point. Although this procedure is
described in the manual, it neglects to say that you need to Shift-click when you drag. The
book says to just click and drag. If you do that, you will de-select the entire track.

Adjusting a Marker in CD Spin Doctor

One thing I do not like about this method is that you cannot Shift-click when choosing a
track. That is why expanding the window to the full size of your screen is so important, as
it will greatly reduce the amount of scrolling.
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Once you are done breaking your music into tracks, you can double-click on each track
and name it. Spin Doctor comes packaged with Toast Titanium, which means that once
you are done with your playlist you can transfer it directly to Toast and burn your CD (but
not before setting the pauses, as described below).

Tracks Defined in CD Spin Doctor

Unfortunately, each time I clicked on the Toast icon button in Spin Doctor things did not
seem to work right. Yes, clicking on the button did launch Toast, but the audio tracks did
not transfer once Toast was fully open. This turns out to be a bug in Spin Doctor under
Mac OS X 10.2. If for some reason the tracks are not automatically transferred to Toast
upon clicking the button, simply select all the tracks in Spin Doctor and drag them onto
the Toast window. This workaround is not mentioned in the manual or on the Web site.
There is a third, also undocumented way to section your recording. First, create a new
folder on your desktop. Give that folder the name of your recording. Now, go back to Spin
Doctor and highlight the first track. Then drag that section of audio to the folder on your
desktop. That track will be copied into a new file in the folder, which you can rename.
Follow these steps for the remaining tracks.
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Montage With Ray Gun Pro
Last month I discussed how to use Ray Gun Pro (RGP) in conjunction with Montage. In
doing so, I left you in limbo as to what to do after setting RGP to your liking. That’s
because before you can actually apply your changes in RGP, you must first section your
recording into tracks and then export them. I should note at this point, in case the
following instructions are hard to follow, that Arboretum plans to release an update to
Montage+RGP in about a month, and the documents are being re-written in areas to
make using Montage and RGP easier to understand and use.
With your recording still encapsulated in RGP, click the dark blue bar area in the music
window. This will turn the music section black. Then, find the first break between track
one and two. At the very top of the music window is a time line bar; click once in the
bottom half of the time line bar, and a blue playback marker will appear. At the top of that
marker is a small blue disk with an arrow within it; clicking and holding on the disk will let
you move the marker to the left or right.
When you have the marker where you want it, select Split from the Edit menu and
Montage will set the first track. Then move to the next break between tracks two and
three, set the marker, select Split, and Montage will create the next break. Repeat this
process for the rest of your recording.
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The thing I like most about this method is that you do not have to set markers up at each
end of a track; Montage remembers where you left off each time. This is very useful when
one track runs into another without a natural break between the two.

Montage: Exporting a Selected Track

It is now time to export the tracks. I suggest that you now take a moment and doublecheck that the settings you have applied by RGP are how you want them, because these
settings will be applied to your tracks as you export them.
Go to each track and click in the dark blue bar, which will highlight that track, then select
Export… from the File menu. A small dialog will pop up; use the default settings and click
OK. Montage will then render that track as an audio file, applying all your settings. Once
this is done, the standard Save window will appear. Create a new folder, name the file,
click Save, and move on to the next track.
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Correction: last month I said you had to buy Montage and Ray Gun Pro together for $250.
It has come to my attention that you can buy Ray Gun Pro by itself with a free limited copy
of Montage for $149. Arboretum did this intentionally so that people who want to work
only with audio do not have to buy the full version of Montage.

Toast: Importing
The next step is to import the individual files you just created into a disc burning program.
I found Toast to be by far the most flexible and user-friendly pieces of software for this
task, although you may prefer to use iTunes. I will discuss how to use iTunes to burn audio
CDs at the end of this article.
In Toast’s main window, select Audio. In the Finder, navigate to the folder you saved your
tracks in, then select and drag all of the files to the Toast window, or drag one file at a
time. If, in Toast, the tracks show up in the wrong order, you can click and drag each track
to another position in the list.

Toast: Burning
To the left of the Title column is the Pause column. Set all the pauses except the first one
to zero. If you do not do this, there will be an extra gap of silence between each track.
This silence will be very different from the transition made going from one track to the
next. I made that mistake on my first attempt, and the result just did not sound right.
Once you have adjusted the pauses, all you have to do is insert a blank CD, click Record,
and let your Mac do the rest.

iTunes
iTunes does not yet offer the means to separate a single recording into tracks, but if you
prefer iTunes to Toast when it comes to burning your CD this is the section for you.
Before you import your tracks into iTunes, open the iTunes Preferences window and click
the Burning icon. Set the Disk Format to either Audio or MP3 CD, with a Gap Between
Songs of None.
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Now, click the Advanced icon. This is very important. Deselect “Copy file to iTunes music
folder when adding to library.” If you do not do this, all of your tracks will be copied into
iTunes’ Music folder, eating up another 500 to 700 MB of space on your hard drive. Click
OK to dismiss the Preferences window.
To import your tracks, first select New Playlist from the File menu. Name your playlist by
clicking on the “untitled playlist” title in the Source column. Then, drag all your tracks
over to the iTunes window. Order the tunes the way you want them, click the Burn CD
button in the main iTunes window, insert a blank CD, and iTunes does the rest.

And the Winner Is
Most of the material I have discussed in the past three months does the job. When it
comes to hardware, do your homework.
I could not be happier with my Stanton ST8–80 turntable. M-Audio makes some great
audio processing cards, and now it has an external version of the Audiophile 2496
retailing as the Audiophile USB, for $249. I hope to have a look at it sometime in the
future. The iMic is a great economical way to record audio on your Mac if it lacks PCI slots.
For $25, I would be crazy not to say that Amadeus II is a great entry-level program for
those who want to test the waters of recording and editing. Spin Doctor is also useful, and
it comes bundled with Toast. Peak LE is great for breaking your music into tracks, but it
will have to wait for Arboretum to release Ray Gun Pro as a plug-in to make it whole.
Montage with Ray Gun Pro is in its early stages, and according to Arboretum the next
update will bring major changes and improvements. If you are serious about your audio
and want to use Montage with Ray Gun Pro, I recommend that you wait till the update
comes out.

Last Words (For Now)
What started out as a one-off article has, to my surprise, mutated into a three-part series.
Before I close—gosh, did I actually say close?—I’d like to make some final points.
First, take your time. Do not try to rush through the whole process. Clean your albums
before recording. The cleaner the album, the less noise will be picked up. Next, be careful
with your filters. Listen to your music often as you apply the filters. If possible, use
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headphones to get a better handle on how your music sounds. Check and double check
as you break your music into tracks. Nothing can be more infuriating than to find out that
you wasted a whole CD by cutting a single track short.
Lastly, I will stress again what I mentioned last month: avoid using the microphone port
when recording onto your Mac. If you use it you run a much greater risk of picking up all
the nice electrical noises created by your Mac’s internal fan, hard drive, CD drive, and
other components.
Next month, I will either do a utility roundup or publish an article that I have been slowly
piecing together on the latest technology in input devices. That is it for now. By the time
you read my next article, another year in my life cycle will have passed. (Yes, I’m a
stubborn Taurus.) Until then…End of Line.
Copyright © 2003 Robert C. Lewis, rlewis@atpm.com. Robert is a Mac consultant.
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How To
by Matthew Coates, hmedia@mac.com

Mac OS X’s Acrobatic Moves
The Myth, the Legend, the PDF
The Adobe PDF (Portable Document Format) is a small wonder of computing—remarkably
versatile, endlessly useful, and simply everywhere. It is the Rosetta Stone of computer
compatibility, a miraculous solution to the oldest hassle in personal computing: we don’t
all have the same stuff.
We don’t have the same computers, or programs, or fonts, or printers, or knowledge
about how it all works. But with the PDF, none of that matters. I know I can always send
you a document that you can open. And you can send one to me. Apparently, we’re doing
a lot of that. No matter what the PDF contains—a bare-bones ReadMe, an IRS tax form,
perhaps an elaborate architectural rendering—it is an elegant realization of the simple yet
profitable concept of a universal file format. A properly-prepared PDF will always look and
print as it was intended.
Adobe’s free Acrobat Reader (soon to be renamed Adobe Reader with the release of
version 6) may be the world’s most common software; Adobe estimates that 500 million
copies are out there, perhaps half of which are on my hard drive.

OS X and the PDF
With new OS X native versions of the company’s PDF-creation software, Acrobat 6, rolling
out this month, you’ll be hearing a lot more about PDF technology, and especially some of
the heavy duty tools featured in the pricier, and heavily promoted, professional version
that’s aimed at the design, graphics, and commercial printing industries.
But most of us do not deal with huge, complex PDFs that a gigantic six-color digital press
would use to print a $79 coffee table book. Instead, we download brochures and
manuals, business reports, government documents, catalogs, and, of course, online Mac
magazines.
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Remember the thrill of downloading that first PDF? And remember how your hopes were
squashed by the realization that Acrobat Reader is look-but-do-not-touch software?
Creating a PDF requires the $250 standard edition of Adobe Acrobat (soon to cost $260),
a lot of money for the occasional user. But, unless you own an application such as
PageMaker with Acrobat’s creation engine already under the hood, purchasing Acrobat
used to be your only option.
Well, forget that. With OS X’s nifty integration of PDF technology, anyone can be in the
publishing business. PDF is a native file format in OS X, meaning that any application with
a Print command can generate a PDF.
There are limitations. Acrobat offers a long list of PDF-creation options; OS X offers none.
OS X creates PDFs that look great on your monitor and generally print just as well. But it
does not offer Acrobat’s sterling ability to compress graphics, nor any other Acrobat
features, such as password protection and document annotation. Still, if your PDF needs
are fairly basic (simple documents without a lot of graphics), OS X’s implementation of PDF
technology will serve you well and save you money.
Creating a PDF in OS X is easy. Although only a few applications offer a convenient “Save
as PDF” command in the File menu, the saving procedure under OS X Jaguar is just as
straightforward: open the Print dialog box and click the “Save as PDF” button. Pick a
destination for the file and you’re done.
Earlier versions of OS X don’t have a “Save as PDF” button. Instead, select “Output
Options” in the Print dialog box’s pop-up menu. Check “Save as File,” select PDF from the
Format menu, and click Print. While this procedure (which also works in Jaguar) is not
exactly intuitive, it does offer a clue about why you’re mucking about in a print dialog box
to save a file. It’s the other file format option: PostScript. The PDF is a sibling of this
complex printer language that has powered a fair-sized chunk of the digital age.
PostScript is the native tongue of many laser printers and high-end imaging devices;
essentially, it tells the printer how to construct a page for printing. Normally, a PostScript
version of a document is sent directly to the printer, but it may also be saved—in geekspeak, a process called “printing to disk.” Acrobat Distiller, Acrobat’s PDF creation engine,
makes user-friendly PDFs from these all-code PostScript files. Until Acrobat came along
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and put a happy face on PostScript, many commercial printing companies preferred to
work from PostScript files, rather than native files from page layout applications, because,
like PDFs, they include everything needed to print a document.
OS X does not use PostScript, which is owned by Adobe, instead relying on the Apple
graphic technology called Quartz. If the PDF is PostScript’s sibling, then Quartz is
PostScript’s cousin. Maybe even second cousin. But you won’t care once your Mac starts
generating PDFs for free.

PDFs and Preview
OS X’s core integration of PDF technology goes beyond generating files. If you frequently
use PDFs, and especially if you often open several at once, consider switching to Apple’s
graphic viewer Preview as your everyday PDF reader. You may already know Preview as a
huge improvement over OS 9’s PictureViewer when it comes to opening and converting
graphics files, but for some users this freebee also is a worthy replacement for Acrobat
Reader.
For me, Preview’s thumbnail feature clinches the deal. When you drag several PDFs onto
the Acrobat Reader icon, each document opens in a separate window. Do the same with
Preview, and you are presented with a single viewer window displaying the first page of
one document and a sliding drawer of generously sized (and adjustable) thumbnails of
each remaining page, and those of the other PDF documents. It’s a terrific feature when
screen real estate is at a premium.
Since Preview is primarily a graphics viewer, it is missing two text-related Acrobat features
you might consider deal-breakers: clickable Web and document links and a Find feature.
And Preview’s Zoom feature is annoying when working with PDFs (and any other file
format, for that matter). The zoom is inexplicably nailed to the center of the window,
while Acrobat and most other Mac applications allow you to move a magnifying glass tool
to change the focus of a zoom. It would be nice to see these problems addressed in the
next version of Preview, but for now, stick with Acrobat Reader when working with
interactive PDF documents.
There are several test-drive options if you’re considering a switch from Acrobat to Preview.
Preview can open Acrobat-generated PDFs via the usual Mac methods for opening a file in
an application that didn’t create it. Or you can choose to have a particular PDF always
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open in Preview. Select the document’s icon, hold down the Option key, and choose
“Always Open With” from the File menu. Then select Preview from the submenu. This
also works via contextual menus.
If you want to make all of your PDFs open in Preview, select the icon of any PDF and
choose Get Info from the File menu. Click the triangle next to Open With, choose Preview
from the pop-up menu, and click Change All. But note that the icon of an Acrobatgenerated PDF won’t change unless you save the PDF with a different name, and the Get
Info window waffles a bit, promising only to use the default application to open
documents that are “like” your sample. Translation: there’s no guarantee this technique
will work consistently.
You may have already taken Preview for a PDF-opening test drive and didn’t know it. In OS
X, the Print dialog box includes a Preview button, and its name is no coincidence. Clicking
the button opens your document as a PDF file in Preview if it is your default PDF
application; otherwise, Acrobat Reader will open.
Before I move on, let’s have a little fun with Preview. Let’s say you have an original
document written in Microsoft Word and named it “I Love my Mac” (without quotation
marks). Click the Preview button in Word’s Print dialog box, and your love letter opens in
Preview. Save it using Save As in the File menu, accepting the default file name for the
document and choosing the desktop as the destination. The result is a PDF with this
oddball name:
Preview of “Microsoft Word—I Love My Mac.doc.”pdf
Alas, if you are contemplating parlaying this oddity into an endless loop of previewed
previews, it won’t work. When you click the Preview button in Preview’s own Print dialog
box, it opens a new PDF but with the mundane name “untitled.” Rats.
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Acrobat Online
Despite all the PDF-generating fun you can have with your Mac, there may be times when
you will need PDF features that OS X can’t deliver. Say hello to Create Adobe PDF Online.
It’s a great resource.

This is the starting screen once a subscriber has logged in.

I use this online PDF maker more often than my copy of Acrobat. If I hadn’t bought the
software before I tried Create Adobe PDF Online, I might not have bought it at all. The
Web-based service is a great choice for small businesses and single users who occasionally
need to make a fully functional PDF but do not want to pay for Acrobat. At $9.99 a month
or a lump-sum $99.99 for a year, you can use the Adobe Web service for more than two
years before the fees amount to more than the price of the software. Chances are, you’ll
spring for an Acrobat upgrade before then, anyway. And you won’t have to spend
anything to try online PDF conversion—the service offers a free demo of up to five file
conversions.
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Create Adobe PDF Online offers most of the significant features of Adobe Acrobat, as well
as a few the software does not currently have such as Paper Capture, which creates
searchable PDFs from scanned paper documents. Paper Capture was dropped from
version 5 of Adobe Acrobat for the Mac despite howls from users (thankfully, it returns in
Acrobat 6).
Adobe’s Web PDF service works with almost any file format, including Microsoft Office
applications; Adobe’s Illustrator, InDesign, Photoshop, PageMaker, and FrameMaker;
WordPerfect; and a long list of graphic file formats including EPS, JPEG, GIF, TIFF, PNG,
along with any other file which can be converted to PostScript before you upload it.
Create Adobe PDF Online offers far too many PDF-making options to go into here, but if
you have used Acrobat Distiller, the boxed version’s PDF-creation engine, you’ve seen them
before. Excellent HTML-based help files lucidly explain the service’s features. For most
users, including beginners, one of five pre-defined option sets for optimizing your PDF will
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be all you need, whether your PDF is destined for the Web, general use, or even
commercial printing. The service’s interface is clean and well-designed; it never gives more
information than a user can handle.

This is the basic window for selecting either the default conversion settings or one which a
user has previously saved.

To use Create Adobe PDF Online, simply browse to a file to convert, choose your settings
(and whether to convert the whole document or a sequential range of pages, such as
pages 4–12), and click Create PDF. Adobe says files up to 5 MB in size usually are
processed within 2 minutes. When the conversion is done you may opt to receive an emailed link to the file, to have the file e-mailed to you as an attachment, to wait for the
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conversion and download the file immediately, or to skip notification altogether and have
the file wait for you to retrieve it from an online holding bin. Whichever option you
choose, the file will be available for up to 72 hours.

One of the screens for adjusting settings.
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The Fonts tab of previous window.

You may convert as many files as you like, but the service caps file sizes at 100 MB and
limits processing to 15 minutes per file (10 minutes for trial members). A Paper Capture
document is limited to 100 pages. If your project breaks the limits, document processing
fails and you are notified by e-mail. Adobe suggests solving the problem by splitting the
project into several parts or converting the original into PostScript before submitting it
again. Realistically, most users are not likely to get close to the size and processing limits.
Unfortunately, either by oversight or design, Create Adobe PDF Online cannot batchprocess incoming documents—a big annoyance. The service will happily churn away on as
many files as you like, but you can add them to the queue for processing and retrieve
them only one at a time. I recently converted 23 Word documents in a session, and while I
had no complaints with the results, getting there was tedious because I had to set the
options for each file.
A suspicious mind would suggest that removing this speed bump could make Adobe’s
online PDF service wildly popular and that’s not necessarily a good thing. It could hurt
Acrobat software sales and, more likely, lead to prohibitively high Web infrastructure costs
to keep up with the demand. The money is in catering to the occasional user who might
not buy the boxed Acrobat software or who uses the service out of the office. There’s
nothing to gain by having the online service cater to bandwidth-hogging, heavy-duty
users. Let them buy the box. But, as the lawyers say, all this is just speculation.
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Create Adobe PDF’s other potential speed bump is the speed of your Internet connection.
If you are working with big files, a broadband hookup is a necessity; fast processing isn’t
much help if it takes forever to send and receive the documents.
The Adobe Web service also can turn a Web site into a PDF, but it does not support
JavaScript or Cascading Style Sheets (CSS), two increasingly common Web site elements.
Compare that with version 5 of Acrobat for the Mac which will convert CSS and offers
partial support for JavaScript; version 6 appears to be even more compatible. If converting
Web pages is a requirement of your workflow, the Web service is not for you. But keep an
eye out for a likely upgrade.
Keep security in mind when using Create Adobe PDF. Do you really want to send a
sensitive document into the ether without knowing who might see it? Probably not. Still, if
you’re making PDFs of sensitive documents the old fashioned way, Acrobat passwords
notwithstanding, you’re already dancing with the Devil.
For the light or occasional user, Create Adobe PDF Online is a terrific and very affordable
resource. And for freelancers who never know where they are headed next, the service
can pay off in unexpected ways.
An assignment recently had me working in an all-PC environment converting Word files
into PDFs. One file simply refused to convert properly; in each of many tries, a graphic was
put in the wrong place. Finally, frustrated, I uploaded the file to Adobe’s Web service. It
was back in minutes, working fine.
The conversion problem may have been the fault of the PC, or Microsoft, or Acrobat for
Windows. There’s even the tiniest chance it was my fault, although I much prefer to blame
Microsoft. But Create Adobe PDF Online was beyond reproach. It did its job, and a Dell did
not plunge from a fourth floor window.
So, there’s a downside to everything.
Copyright © 2003 Matthew Coates, hmedia@mac.com.
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Cartoon: Cortland
by Matt Johnson, mjohnson@atpm.com
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Copyright © 2003 Matt Johnson, mjohnson@atpm.com.
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Extras: Desktop Pictures
Flowers—Part 3
Flowers—Part 3
The pictures presented here are courtesy of Jens Grabenstein. They were taken in June
2002 on a two-week road trip through California starting from San Francisco. The images
reflect the cultural and natural diversity of this beautiful state.

Previous Months’ Desktop Pictures
Pictures from previous months are listed in the desktop pictures archives.

Downloading all the Pictures at Once
iCab and Interarchy (formerly Anarchie) can download an entire set of desktop pictures at
once. In iCab, use the Download command to download “Get all files in same path.” In
Interarchy, use HTTP Mirror feature.

Contributing Your Own Desktop Pictures
If you have a picture, whether a small series or just one fabulous or funny shot, feel free to
send it to editor@atpm.com and we’ll consider publishing it in next month’s issue. Have a
regular print but no scanner? Don’t worry. E-mail us, and we tell you where to send it so
we can scan it for you. Note that we cannot return the original print, so send us a copy.

Placing Desktop Pictures
Mac OS X 10.1.x and 10.2.x

Choose “System Preferences…” from the Apple menu and click the Desktop button. With
the popup menu, select the desktop pictures folder you want to use.
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You can also use the pictures with Mac OS X’s built-in screen saver. Choose “System
Preferences…” from the Apple menu. Click the Screen Saver (10.1.x) or Screen Effects
(10.2.x) button. Then click on Custom Slide Show in the list of screen savers. If you put the
ATPM pictures in your Pictures folder, you’re all set. Otherwise, click Configure to tell the
screen saver which pictures to use.
Mac OS X 10.0.x

Switch to the Finder. Choose “Preferences…” from the “Finder” menu. Click on the
“Select Picture…” button on the right. In the Open Panel, select the desktop picture you
want to use. The panel defaults to your “~/Library/Desktop Pictures” folder. Close the
“Finder Preferences” window when you are done.
Mac OS 8.5–9.x

Go to the Appearance control panel. Click on the “Desktop” tab at the top of the
window. Press the “Place Picture...” button in the bottom right corner, then select the
desired image. By default, it will show you the images in the “Desktop Pictures” subfolder
of your “Appearance” folder in the System Folder, however you can select images from
anywhere on your hard disk.
After you select the desired image file and press “Choose,” a preview will appear in the
Appearance window. The “Position Automatically” selection is usually fine. You can play
with the settings to see if you like the others better. You will see the result in the little
preview screen.
Once you are satisfied with the selection, click on “Set Desktop” in the lower right corner
of the window. That’s it! Should you ever want to get rid of it, just go to the desktop
settings again and press “Remove Picture.”
Mac OS 8.0 and 8.1

Go to the “Desktop Patterns” control panel. Click on “Desktop Pictures” in the list on the
left of the window, and follow steps similar to the ones above.
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Random Desktop Pictures

If you drag a folder of pictures onto the miniature desktop in the Appearance or Desktop
Pictures control panel, your Mac will choose one from the folder at random when it starts
up.
DeskPicture

An alternative to Mac OS’s Appearance control panel is Pierce Software’s DeskPicture,
reviewed in issue 5.10 and available for download.
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Review: Google Hacks (book)
by Kirk McElhearn, kmcelhearn@atpm.com

Author: Tara Calishain and Rael Dornfest; published by O’Reilly.
Price: $24.95
Trial: Some sample hacks.

As many Web users know, Google is the ultimate search engine. With
the largest number of pages indexed and one of the fastest interfaces,
Google is the search engine of choice for most serious Web searchers. I personally use it
dozens of times a day, and only rarely use other search engines. Google offers powerful
search syntax, cached pages, a directory, newsgroup searches, and the recent Google
News service, which has quickly become one of the Internet’s most essential sites. Unlike
most other search engines, Google is not a portal; if you want to search Yahoo, you have
to suffer its cluttered page layout, irritatingly frequent advertisements and oh-too-many
bright colors. In contrast, Google offers a minimalist interface with maximum usefulness.
You can search for a lot of things by just typing a few keywords into a search field, and
you’ll get useful results. But the real value of any search engine, and especially Google, is
doubled when you learn the search syntax, or language, that allows you to refine your
searches. The first part of this book begins with the basics of Google searching, and goes
on to explain all the fine points of its syntax. You’ll learn how to restrict your searches to
different types of documents, languages, domains, or dates. You’ll discover how to search
for certain types of files, such as PDFs, Word files (.doc), PowerPoint files (.ppt) or others.
And if you want to hack some HTML, you’ll learn how to make your own Google search
form to put on your Web site or personal search page.
The bulk of this book, however, is not for casual searchers. Some 200 pages talk about
integrating Google searches with more complex tools such as SOAP and Perl, XML, and
using the Google Web API with PHP, Java, Python, C#, .NET, and VB.NET. Google’s real
strength for programmers is the possibility of integrating it into other tools, and finetuning the results to provide the highest possible level of pertinence. There are also tips for
webmasters, telling them the best way to set up their pages to get better and more
targeted rankings.
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Programmers and webmasters who want to work with Google and exploit its results will
find a wealth of material in this book. Simple Web searchers will also learn to save time
and get the most precise results from Google searches. The section on search syntax and
the tips for getting the right results are worth far more than the cost of this book in the
amount of time you can save and the quality of results you’ll get from Google. This is a
valuable book, full of useful tips, and one that will enhance anyone’s use of Google.
Copyright © 2003 Kirk McElhearn, kmcelhearn@atpm.com. Reviewing in ATPM is open to anyone.
If you’re interested, write to us at reviews@atpm.com.
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Review: Pocket Tanks 1.00b
by Dan Boland, dboland@atpm.com

Developer: Cornerstone TSP Games
Price: $15.99
Requirements: Mac OS 8.6 or Mac OS X 10.1, 800x600 resolution
Recommended: 233 MHz G3
Trial: Feature-limited (no Deluxe version features)

Whether or not you remember the classic game of warfare called Scorched Earth, you can
now enjoy it on your Mac in the form of Pocket Tanks by Cornerstone TSP Games.
While the premise—two tanks shooting at each other—remains the same, there are plenty
of options to keep even seasoned veterans interested. The variables you can change
include wind, terrain, and explosion size. Although none of these options are
revolutionary, Scorched Earth would not be the same without them and Pocket Tanks
delivers the goods.
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Now for the most important part: the weapons. The freeware version of this game comes
supplied with thirty weapons, the vast majority of which are offensive. Each player has ten
weapons to choose from out of a randomly selected twenty; the final ten can also
optionally be randomly selected. The purpose of the game is to outscore your opponent
using the weapons you’ve chosen.

Weapons Selection Screen
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As expected, scoring is based on a combination of the vicinity of the explosion and the
power of the weapon. Some weapons are more useful than others, but of the thirty
included in the freeware version, only Tracer could be considered completely useless.

Beware the Pineapple!
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Pocket Tanks is fun. It is easier to waste away an hour or two with this game than one
might think. The graphics and music are solid and appeal to the eye and ear. Strategy
buffs will enjoy the closer matches, and explosion fanatics will revel in destroying their
buddy’s tank.

ATPM Wins Again!

I do however have a few gripes about this game. Even with ten levels of difficulty, I find
myself winning at the hardest level nine out of ten times, whether I choose the weapons
myself or let the game do it for me. A four-player mode would be nice as well, although I
might just be being picky. But if anything, I must stress this: not everyone will like this
game. Regardless of its features, some people (my fiancée included) will think this game is
boring and stupid.
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All the Deluxe version offers is thirty extra weapons and the promise of future weapons
expansion packs. There are no additional options or harder difficulties. If you think it is
worth the money, then by all means, update to the Deluxe version; I, on the other hand,
have plenty of fun playing the free version.
For those who love Scorched Earth, Pocket Tanks is a version worthy of your time.
Although I don’t think the Deluxe version is worth the money, the freeware version makes
a terrific download.
Copyright © 2003 Dan Boland, dboland@atpm.com. Reviewing in ATPM is open to anyone. If you’re
interested, write to us at reviews@atpm.com.
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Review: SPSS 11.0
by David A. Zatz, dave@allpar.com

Developer: SPSS, Inc.
Price: $1,145 (base); maintenance (recommended) starts at $287; upgrade from SPSS 10
for $299; upgrade from SPSS 6 for $499. Academic pricing starts at $599 (base).
Many users will need extra modules. Training manuals (recommended) are around
$100 each.
Requirements: G3 with 192 MB RAM, 256 MB of hard disk space, Mac OS X 10.1.2.
Recommended: 500 MHz G4, 256 MB RAM.
Trial: None

The statistical analysis application SPSS entered the Mac market with a lean, efficient,
syntax-driven program. Version 4 would let you use menus, but those menus would simply
build syntax on the screen, helping users to use the powerful program as efficiently as
possible. It had many deficiencies—among other things, it produced its results in a
mainframe-style monospaced font—but it ran rather quickly on a Mac Plus, and helped
beginners get used to the SPSS syntax language.

Unfortunately, after a disastrously bad port of version 6—which switched to a more
modern menu-driven system, with syntax “also” available—SPSS abandoned its Mac
customers.
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Then, about two years ago, SPSS contracted with MacKiev to port version 10 over to the
Mac. The result was a program with the capabilities of the Windows version, including a
wide variety of plug-in modules and good speed. Now, version 11 has been ported
over—but only to OS X. If you use OS 9, you must stay with version 10. But those who
recently purchased new computers, only to find they cannot boot into OS 9—and that
SPSS 10 won’t work in the Classic environment—will be very happy about the new
release.
As with prior versions, as you slice, dice, and weight data, and pop out scatterplots using
the built-in menus, SPSS automatically records your syntax into a “journal,” which you can
later modify as a kind of macro to quickly run lots of analyses very quickly. I recommend
buying the optional syntax guide and typing your commands as often as you can, instead
of using the menus. Using SPSS becomes much, much faster that way.

Most of SPSS’ capabilities remain from version 10, and I will refer you to that article rather
than going back through them.
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As with version 10, the major drawback to the program is a long boot time. Version 10
booted in 30 seconds on my beige G3, despite an upgraded hard drive and processor.
Version 11 takes 45 seconds on my blue and white G3, with an upgraded hard drive and
400 MHz G4 processor. No doubt it’s considerably faster on more modern models. While
screen redraws are very sluggish on older machines, calculations are tolerably quick. I
suspect the part of the program that actually does the work uses only highly optimized
(and probably very old in many cases) code, while the user interface was developed with
less concern for processor time. SPSS’ Windows origins are otherwise hidden. It looks and
acts like a real Mac program, using standard OS routines.
The data, output, and syntax views all have different sets of menus, as they do in
Windows: for example, you have to be in the data window before you can use a menu to
split the file. This can be annoying, but it does keep the menus to a manageable size.
SPSS has done a wonderful job of maintaining the syntax through all Mac and Windows
versions, so that files written for older versions work without a hitch. The data format is
also compatible without conversion across versions and platforms, making it easy to share
data and scripts with Windows people or users of older Macs. Data is stored in a highly
compressed format, in a break from Microsoft’s norms of oversized files, but matching
SPSS’ mainframe heritage. There are only two major issues with compatibility: SPSS 11 for
Windows output files cannot be shared with SPSS 10 (or earlier versions) for the Mac, and
SPSS’ scripting language (not to be confused with syntax!) was not ported over, since SPSS
11 can now use AppleScript.
SPSS 11, like prior versions, also reads tab-delimited and fixed-format ASCII text and Excel
files. Output files can be saved as HTML for posting on the Web. SPSS also sells programs
that allow other people to view the results and delve deeper into the data.
SPSS also deserves credit for porting over just about all the modules available under
Windows, so Mac users aren’t faced with overpriced crippleware. Indeed, the prices match
the Windows versions, despite porting costs. The main deficiencies of the Mac version,
compared with Windows, are being one-half version behind (Windows is up to 11.5);
missing features include not being able to directly import SAS files, the loss of the Method
subcommand of Crosstabs, and three subcommands of nonparametric tests (both of the
latter are missing from the optional Exact Tests module).
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New features include direct publication to the SmartViewer Web Server, an extra-cost
option that allows quick and easy dissemination of results throughout an organization (or
to the world). Data can now be restructured so multiple cases can form a single case, or
vice versa, which will save some researchers incredible amounts of time and nuisance. A
database wizard can recode string values to numeric variables, obtain random samples,
and do other clever, time-saving tasks that once required workarounds or other software.
Other clever features for quickly rearranging data, such as the innovative pivot controls,
remain.

The optional and very handy Reports module now produces modern output, with tabdelimited tables instead of the old monospaced fonts. It’s still only camera-ready if you’re
not very particular, but it’s much better than in the past, and individual tables can quickly
be modified for acceptable results. The Reports module can save a great deal of time
when, for example, analyzing survey data. This and the Advanced Statistics modules are
almost “must-haves.”
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The OLAP cubes facility has been upgraded to allow calculation of differences between
variables. Those who hate scientific notation will be glad to know it can now be
suppressed in all output. This upgrade does not just deal with system software and
appearance issues; a number of statistical upgrades were also made. These can be
explored fully on SPSS’ Web site, and may affect a surprisingly large number of users.

Most people will probably export SPSS tables and charts to other programs for
publication, usually by copying and pasting to the other application, but SPSS 11’s tweak
to output tables—adjusting the column width to match output—makes it easier to simply
save output as PDF (or HTML) and use it without modification. This may be the greatest
time-saver of the new version for some people.
While SPSS seemed stable on my system, an early blue and white Power Mac with only
448 MB of RAM and a 400 MHz G4 upgrade, I did experience a corrupted preferences
folder which required re-installation (resetting permissions did not help), and the program
seemed to lock the Command key down at times. Syntax pasted in from the Classic
Scrapbook did not work properly and had to be retyped, though syntax from older
versions ran well when opened normally. In extended testing, SPSS sometimes crashed
when being closed, and some parts of the output sometimes refused to use certain fonts.
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SPSS 11 makes it easy to take heavy-duty statistics into the world of OS X. The fact that
SPSS 10 and 11 are mutually exclusive also makes it easy to decide on upgrading—if you
stay in OS 9, you cannot use SPSS 11, and if you move to X, you have to.
Because SPSS has such a slow interface, I strongly recommend that you do not use it with
older machines or less powerful laptops. A 700 MHz G4 or above is just about required for
tolerable speed, and a faster processor is really needed to make the program enjoyable in
everyday use. If that means staying with OS 9, it may just be worth it to keep the relatively
snappiness of SPSS 10. Version 11 does not add enough new features to justify an
upgrade for many users (except, as noted, for OS X compatibility, which is downright
needed for those with machines that won’t boot into 9).
SPSS 11 is capable, fairly user-friendly, and easier to work with than previous versions. The
number crunching is very fast, and the reports increasingly easy to use in presentations
and articles. It is no small wonder that SPSS 11 is still the market leader in professional
statistical analysis.
Copyright © 2003 David A. Zatz, dave@allpar.com. Reviewing in ATPM is open to anyone. If you’re
interested, write to us at reviews@atpm.com.
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Review: Ten Thumbs Typing Tutor 2.2.2
by Gregory Tetrault, gtetrault@atpm.com

Developer: Runtime Revolution
Price: $25.95
Requirements: Power Mac with System 7.1 or Mac OS X 10.1.3; 16 MB of application
RAM; 800 x 600 resolution with 256 colors.
Recommended: Mac OS 8.0; QuickTime 4.0 (to play background music).
Trial: Fully-featured (10 days)

Overview
Ten Thumbs Typing Tutor is designed to teach novices how to type and to help
intermediate to advanced typists type with greater speed and accuracy. It uses a
combination of structured lessons and typing games to achieve those goals.
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Installation and Setup
The download file is a StuffIt archive of the Ten Thumbs Typing Tutor folder. After
decompression, the application is ready for immediate use. When you launch Ten Thumbs
Typing Tutor for the first time, you are asked to register. If you do not register, the program
will function for only ten days. You will also encounter a window displaying a “Tips ’n’
Trivia” window.

Tips window with option to hide.

You can avoid this by unchecking the box in the lower left corner. You next see a log-in
screen for identifying yourself. Ten Thumbs Typing Tutor allows multiple users per
computer. After you identify yourself, Ten Thumbs Typing Tutor presents a “quiz” which
asks about your typing goals and your preferences. You can answer the questions on each
screen or you can skip sections. You can choose either QWERTY or Dvorak keyboard
layouts. Once you have finished the setup quiz, Ten Thumbs Typing Tutor proceeds with
the first lesson.

Using Ten Thumbs Typing Tutor
Ten Thumbs Typing Tutor has one main window. Choices (seven program areas plus Quit)
appear as eight buttons at the bottom of the window. Ten Thumbs Typing Tutor opens
with a structured lesson. The lessons are based on information provided during the setup
ATPM 9.05
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“quiz” and on performance in previous lessons. Lesson screens contain a block of text to
type at the top and information about your typing performance below. For novices, the
displayed information is a map of the keyboard. For more advanced users, graphs of the
overall speed and error rate and last line speed and error rate are displayed. The timer
starts with the first key you type. When you finish typing a line (by pressing the spacebar
after typing the last visible character), a new line appears. There is no option for scrolling
text. Ten Thumbs Typing Tutor will give visible (red text) and audible (beep) clues for each
mistyped character if you selected those options during the setup “quiz.” The lesson will
not progress until you correct all errors in the displayed line. There is no option that allows
you to continue without correcting errors.

Main window with Lesson showing.

Extra Practice offers four options: “Practice worst keys” (based on your previous results),
“Import text,” “See fingering” (shows fingering for a single key), and “Practice typing
keys” (that you choose). “Practice worst keys” creates random strings of characters. For
example, my worst keys were @, #, and ?. Thus, my practice lines looked like this: @@##?
@?@ ##@@ @??#. “Import text” lets you select any file. Ten Thumbs Typing Tutor strips
out non-printing and non-standard characters and then displays the resulting text line by
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line (just like the lessons). The practice session ends when you reach the end of the
imported text. “Show fingering” shows hand and finger placements for typing a
character. Placement includes the use of the Shift key when relevant. “Practice typing
keys” is the same as “Practice worst keys” and consists of random clusterings of the
characters you chose.

Extra Practice

The Safari Park game has a boat being rowed and sailed down a meandering river. There
are four bridges that will block the boat unless you correctly type the characters in the
turtle or alligator boxes. At higher levels, the boat moves faster. At lower levels, the game
is incredibly boring. Even if you complete all the typing in a few seconds, you have to wait
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for the boat to slowly wend its way across the bottom of the screen. Ten Thumbs Typing
Tutor does not remember the last level you achieved, and there is no way to start at a
higher level. You also have no control over the characters to be typed.

Safari Park

The Brick Factory game has character-containing bricks falling on the left side of the
screen. If you correctly type all the characters, the brick is sucked into the machine to the
right. If you fail to type the characters quickly enough, the brick lands on a conveyor belt
and is discarded onto a pile. When the pile gets too high, it falls over and you lose a life.
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Brick Factory makes little sense. Even at the lowest level, a brick can contain up to 12
characters. Other bricks may have only two characters. Character strings are usually
words, words plus punctuation, or number strings.

Brick Factory
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The Options window gives only three options related to the background (black or off) and
to music and sound. To change other characteristics of the program, you must retake the
setup “quiz.” I found this to be a cumbersome and annoying process.

Help
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The Help window contains a list of seven topics in an upper window and information on
the selected topic in a lower window. I found this section unhelpful.

Report window immediately after completing a lesson.
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The Report window summarizes the results of your last lesson or activity. There is no way
to review previous reports. The Report window has a different format if the button is
clicked immediately after launching (or logging in as a new student) Ten Thumbs Typing
Tutor. This “Student History” report summarizes overall progress.

Progress report for a student.

Problems and Bugs
I crashed while playing Brick Factory when I accidentally pressed the Return key. The crash
required a forced restart under OS 9.
The ReadMe file warns that you should not change monitor resolutions while the program
is open.

Omissions
The biggest omission is that Ten Thumbs Typing Tutor does not follow Macintosh interface
guidelines. This program feels like a crude port from a Windows version. It does not use
Macintosh menus or dialog boxes.
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Ten Thumbs Typing Tutor does not offer any typing tests (separate from lessons or
imported text). Other omissions are mentioned in the “Using Ten Thumbs Typing Tutor”
section.

Documentation
Ten Thumbs Typing Tutor comes with a short ReadMe text file. No other documentation
(except for the meager contents of the Help window) is available.

Technical Support
E-mail support and fax support are available. There is no live telephone or online support.
I did not test the rapidity or accuracy of e-mail support.

Alternatives
Mavis Beacon Teaches Typing version 9 is available for $20 from Broderbund (North
America) or from Mindscape (Europe, Asia, Latin America). Mavis Beacon Teaches Typing is
far more polished and complete than Ten Thumbs Typing Tutor. I have used an older
version for years and recommend it highly.
Typing Tutor 10 (Pearson Software) is no longer published but is still being distributed by
many vendors (including Amazon.com). It sells for around $20. I haven’t used it, but it got
very good customer reviews on Amazon.com.
Disney’s Adventures in Typing with Timon & Pumbaa (Disney Interactive) also is no longer
published but is still available. It sells for around $10. It is designed for young novice
typists. My daughter used it last year (when she was eight years old) and liked it.
Roller Typing (Edventure Softare) uses the sport of rollerblading as a theme for typing skill
games. It lists for $30, but its street price is around $25.
Jumpstart Typing from Knowledge Adventures (distributed by Vivendi Universal Games) is
part of the Jumpstart educational software series. It is designed for children in grades 3–5.
It is available from Amazon.com for $10. A new version, Jumpstart Typing 2003, will be
available in June for $20.
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Summary
Ten Thumbs Typing Tutor feels like a crude port of a mediocre Windows program. It is
functional, but other programs are much better and often cost less.
Copyright © 2003 Gregory Tetrault, gtetrault@atpm.com. Reviewing in ATPM is open to anyone. If
you’re interested, write to us at reviews@atpm.com.
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Review: TiVo Home Media Option
by Eric Blair, eblair@atpm.com

Developer: TiVo, Inc.
Price: $99 (first TiVo in household); $49 (additional TiVos in household)
Requirements: 400 MHz G3, TiVo Series2 DVR, USB Network Adapter, Mac OS X 10.2,
iTunes 3.0.1, iPhoto 2.0, home network.
Trial: Fully-featured (30 Days)

It seems like members of the press and the computer industry have been talking about the
convergence of computers and home entertainment systems for years. When the topic
comes up, somebody almost always wants to tell you how computers will move into the
living room. However, just about every attempt to put a computer in the living room has
been a miserable failure. There are numerous reasons why these devices have failed, but
the basic lesson is that computers and televisions haven’t played well together.
Within the past two years, the number of people with home networks has increased
dramatically. Some companies have realized that, thanks to networking, you can put your
computer wherever you want it and still reap many of its benefits. Given the popularity of
MP3s, it’s not surprising that many of these products are designed to connect your
computer to your stereo system.
TiVo, the maker of digital video recorders that people either adore or know nothing about,
has entered the world of home networking. Their Home Media Option is more than just
an MP3 player in the living room—it also lets you view photos on your computer, share
recordings among other TiVos in your house, and schedule recordings over the Internet.
This review will focus mostly on the Digital Photos and Digital Music portions of the Home
Media Option.

Setup
I wasn’t really sure what to expect when I tried to configure my TiVo for use in my existing
network. One of TiVo’s selling points is that it’s simple to use. However, many of TiVo’s
subscribers are the sort of people who want to control every aspect of their home
network.
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TiVo seems to have both ends of the spectrum with their configuration options. If you just
want to plug in and go, your TiVo can automatically select the appropriate configuration
options via either DHCP or BootP. If you want total control, you can specify all the network
settings. I chose the latter option and was presented with a series of easily-understandable
configuration screens. When I entered a typo that would have prevented the TiVo from
connecting to the network, a warning message was displayed and I could not continue
until I fixed the error.
To make your Mac share its music and photos with your TiVo, you need to install TiVo
Desktop. TiVo Desktop is a Preference Pane that reads both your iPhoto and iTunes
libraries to determine what sort of media you have on your computer. It also sees your
iTunes playlists and your iPhoto albums, so you can choose to share only portions of you
libraries.

Sharing some of your iTunes Playlists.

Honestly, the functionality of TiVo Desktop sounds like it belongs in the Sharing Preference
pane, but I’m not certain if Apple allows third-party developers to add entries to the list of
services.
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Although this all sounds straight-forward, I hit a major snag during my initial setup—my
TiVo just did not see my Mac. It turns out this was due to having turned on OS X’s built-in
firewall, and made worse by the fact that TiVo did not have its Macintosh documentation
complete when it released the Home Media Option. Currently, the documentation is
available and the answer to this problem is basically to open ports 8101, 8102, and 8200
on your firewall. If you don’t understand what this means, don’t worry—the new
documentation does a very good job of explaining it.

Interface
After you purchase the Home Media Option, an appropriately named Music & Photos
option appears in your TiVo Central menu. When you select this option, you see a list of all
the people sharing music and photos via TiVo Desktop on your network.

See who’s sharing music and pictures on your
network.

Music
The Music screen shows you every playlist you’ve elected to share in the TiVo Desktop
Preference Pane. Additionally, iTunes creates four “playlists” of its own that you can
choose to share with your TiVo: iTunes Artists, iTunes Albums, iTunes Genres, and iTunes
Songs.
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These four “playlists” show up as folders in the Music screen. The first three contain subfolders for each artist, album, or genre, respectively. iTunes generates these groupings
from the ID3 tags associated with each of your MP3s, so you should make sure the
information in your music library is correct to use the Home Media Option to its fullest.
The fourth list displays all of the songs you are sharing.
Playlists behave as you would expect—whatever songs you have in the playlist in iTunes
are in the playlist on your TiVo. TiVo also supports both normal and Smart playlists, though
it cannot update Smart playlists. From the Music menus and playlists, you can either listen
to a particular song or listen to a whole playlist by pressing Play on your remote when you
highlight a playlist of folder.
Listening to music is a fairly straightforward affair. Your options are limited to shuffling
your music, repeating your music, and whether or not you should play any sub-folder in
your current playlist. While you are listening to music, your TiVo will either display a blank
screen or some textual information about the currently-playing song. You can move
around within the song with the fast-forward and rewind buttons on your remote and
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advance to the next song with the Channel button. Additionally, your TiVo can also display
some basic information about songs from the menu system, assuming your ID3 tags are
correct.

Getting information about a song.
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Photos
The Photo menu works somewhat differently from just about any other function in the
TiVo. Instead of items running down the left side of the screen, your screen is broken
down into a 4 x3 grid. Each entry in the grid can contain an item from your photo
collection, along with a preview.

Previewing a number of jellyfish photos.

In theory, this lets you easily see all the pictures on your computer while staying within the
menu system. Since the Home Media Option gets your photo albums from iPhoto,
though, the first Photo menu contains nothing but folders representing the different
photo albums. I suspect the Photo menu system was designed this way for Windows
users, since Windows uses completely different methods to organize pictures.
On the bright side, TiVo determines the name of the pictures based on the titles set in
iPhoto as opposed to the seemingly random names your digital camera assigns to files.
Slide shows work pretty much as you would expect—every photo in the selected album is
displayed on the screen for a few seconds at a time. As with listening to music, your slide
show options are fairly limited: time per photo, shuffle, and repeat.
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In addition to viewing a slide show, you can display a single image or get information
about a photo. When getting information about a photo, you can see the date the picture
was taken, the date it was imported, and the date it was modified. You can also rotate the
picture in 90° increments, if necessary.
When displaying photos on the television, TiVo scales the photo as large as possible
without distorting the proportions. If the photo won’t scale to the full size of the screen
(common with rotated or cropped images), the picture will be displayed with a black
border.

Only the Basics
I have essentially the same complaint about both playing music and slide shows: the
options are far too basic. Music playback doesn’t support any sort of cross-fading. There
aren’t any transitions when images change during a slide show.
However, my biggest complaint is that you can’t mix audio and video. After using the iLife
applications, it seems natural to have music playing in the background during a slide show
or to have visual effects while listening to music. With the Home Media Option, though,
it’s one or the other—visually boring music or silent slide shows. Since your TV has both a
screen and speakers, the TiVo should be able to use both of them at once.
Also, the Digital Music option is currently limited to playing MP3s. If you have music
you’ve imported into iTunes in the AIFF or WAVE formats, you won’t be able to play them
on your TiVo. More importantly, this means your TiVo cannot play AAC files ordered from
the new iTunes Music Store or encoded by iTunes 4. Fortunately, the Digital Photo option
is a bit more forgiving in terms of file formats—it supports JPEGs, GIFs, BMPs, TIFFs, and
PNGs.

Beyond Music and Photos
I haven’t really touched on Remote Scheduling and Multi-Room Viewing for a few
reasons. First, I haven’t had a chance to use either feature yet. Second, the behavior of
these portions aren’t anywhere near as Mac-specific as the Digital Photos and Digital
Music features. Finally, I really think that the Digital Photos and Digital Music option are
the more important features.
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Is It Worth It?
The way I see it, people interested in the Home Media Option will fall into at least one of
two categories—people who already own Series2 TiVos, and people who want their
digital music and photos accessible from somewhere other than their computers.
If you already own a Series2 TiVo, the Home Media Option presents a significantly less
expensive option for accessing your digital music via your entertainment center than its
competitors—both the Slim Devices SLIMP3 and the Turtle Beach AudioTron cost more
than $200 and aren’t integrated with iTunes. I looked briefly around the Internet for a
stand-alone product that has similar functionality to the Digital Photos portion of the
Home Media Option, but wasn’t able to find anything.
If you don’t already own a Series2 TiVo, the answer isn’t as easy. You need to factor in the
cost of purchasing a TiVo, either the monthly or lifetime fee for the basic TiVo service, and
the cost of the Home Media Option. If you just want either the Digital Photos or Digital
Music functionality, there are certainly less expensive ways to accomplish this.
Personally, I already owned a Series2 TiVo with the lifetime service plan before the Home
Media Option was announced. Since I was already looking at home entertainment
devices, $99 seemed like a small price to pay when compared to the competing, standalone devices.
Copyright © 2003 Eric Blair, eblair@atpm.com. Reviewing in ATPM is open to anyone. If you’re
interested, write to us at reviews@atpm.com.
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Review: World War 2 Online

Review: World War 2 Online Blitzkrieg
by Joe Kudrna, joek@wt.net

Developer: Cornered Rat Software
Price: $34.99; online service costs $12.99/month with one-month free trial and
additional free months for recruiting new players.
Requirements: 800 MHz G4, 512 MB of RAM, 64 MB VRAM, 1 GB free hard disk space,
Mac OS X, joystick.
Trial: One month free online, “boot camp” map for unlimited offline practice.

About This Simulation
WW2 Online Blitzkrieg is played online with hundreds of others across the world.
Considering its emphasis on detail, it is in more respects a simulation than a game,
meaning WW2OL is arguably the first “Massively Multiplayer Combined Arms
Cooperative Operation Real Time Simulation” ever.
What separates this war game from all others is its combined arms. It utilizes infantry,
tanks, aeroplanes, and ships, and offers the ability to share the operation of a vehicle with
another player in a constantly changing strategic environment. This is the most audacious
attempt to date at recreating this period of history, and for the most part it has succeeded.
This simulation is set during the 1940 German “Blitzkrieg” across a richly detailed
Northern Europe, as French and British forces do their best to stem the tide of the
overwhelming German assault. It takes place in a half-scale virtual model of northern
Europe. There are huge cities and small villages, connected by roads, rivers, and railroads.
The nature of the map offers the option of simply travelling across Europe in an aeroplane
or truck, but this will take time. Just to fly to the German border from Dover in England
takes an hour and a half in real time!
The object of the game is relatively simple: stop the enemy from capturing territory. The
ways of achieving this goal are varied and ever changing. You initially “spawn” in your
choice of vehicle or as infantry at your location of choice, do your duty, and if you survive
you “spawn out” and receive promotion points. There are dozens of vehicle types and a
handful of infantry types available, and you can choose either to join your teammates or
to join other groups.
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The Germans usually win, upon which point the map is reset, but there is every possibility
the Germans could be stalled past the typical two-month game cycle.

A truckload of allies arrives in town, ready for action.

The box contains the game CD, a simple 52-page user manual, and a useful but dated
map of Northern Europe. The CD contains additional images and music not found in the
downloadable version. The box states some hefty requirements as mentioned above,
noting a lack of support for dual-CPU machine configurations, but my experience has
shown that it can run quite well on a lesser machine. Cities, aircraft, and heavy action with
large groups of players require powerful machines, but if you avoid those you can still
have fun using lower end machines.
I have been playing this simulation on my 500 MHz PowerBook G3, with 640 MB RAM
and a paltry 8 MB of VRAM. While the game is for the most part playable, a reasonable
minimum specification for adequate game play would be a 600 MHz G4 with 512 MB of
RAM and 16 MB of VRAM with L3 cache.
It is important to note the L3 requirement, because the G4 iMac, eMac, and new 12"
PowerBook which lack this L3 cache perform surprisingly poorly running this game! To use
the tanks, big guns, and airplanes, it goes without saying that the game will require a
joystick, and a good one at that. Fortunately, quality joysticks retail for as low as $25.
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When using the game’s bundled configuration utility, it is best to start with minimum
settings and increase over time, starting with the resolution and observing frame rate
changes (if the FPS rate is not shown, press the Num Lock key). Higher settings make the
environment look better, but may reduce performance. The bottom left ‘?’ button, when
clicked, displays detailed descriptions of each of the settings.
There have been a dozen updates to this game since the first Mac version came out (and
dozens more on the PC side), but this is the first time I can honestly say it’s a Really Good
Thing™. There is an amazing and constant effort to improve the game, with user polls
conducted and suggestion requests accepted. Since I started playing, the developers have
added new effects, new terrain, a dozen more towns, one armored car, three tanks, and
five new airplanes, pushing the total number of vehicles into three figures. The
improvements in version 1.8.4 are substantial. There may already be additional vehicles by
the time you read this!

Looking at town from river bridge.

Joining the Squad
With this in mind, it is best to download and use the full game installer from the site
(about 99 MB) instead of installing from the CD, which carries version 1.6.8. By default,
files install to the “PlayNet” folder within the Applications folder, although this can be
changed.
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A plug-in for your Web browser is also installed, meaning you should quit your Web
browser before installing. As ATPM went to press, this plug-in is incompatible with Apple’s
Safari browser, and I have only tested it with Internet Explorer.
To create an account, go to the Web site’s Account/Getting Started area, enter the CD Key
found on the case along with some personal and billing information, and take your time
to choose a user name and password you’re happy with. You can change your user name
at a later stage, but it will cost a little extra. Once you have signed in, you can then choose
a squad to join.
Teammates help you play the game, coordinate the missions, and give a sense of
familiarity and welcome. The option to play elsewhere or on the opposite side is still there,
but once familiarized with the game, joining up will offer great camaraderie. There is a
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feature in the “radio” window to instantly chat with specific squad members or an
individual. Being a member also gives you posting access to the Forum; Support-Mac is
very helpful with questions. There is already a vibrant community of players.

As you gain experience, you gain rank and privileges!

War Games
This game is possibly unique, in that it is launched from a Web browser. On the Web site,
choose a side (Allies or Axis), read the news and orders for the day, and then click the Join
button. This activates the PlayNet plug-in, which quits your browser and launches the
game. Once loaded, you are shown a map of recent activity. Use the map to zoom in on
an area or view a list of active missions or attacks that you can join. The entry screen also
lets you modify the key map, and view your progress to becoming a general.
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Once a mission and vehicle are picked, hit Launch and the game drops you onto the map.
Most of the time you will spawn in a relatively quiet area and move to the front line by
land, air, or sea; but sometimes you may spawn in the midst of heavy action! Just as in the
real war, information is scant, and your on-screen display offers basic health meters, a
direction indicator, and a short-range map.
The environment is detailed enough to look impressive. There are day and night cycles, but
the transitions happen about four times faster than normal. The game follows the laws of
physics, from gravity right down to weapons recoil and the swaying motions of vehicles.
You can have accidents; if a truck you are riding hits a bump or a tree, people will be
thrown out and injured!
Because there are so many vehicles in the game, there are configuration settings for each
class and individual vehicle, as well as settings for up to four different joysticks attached to
the same computer, or for four players using the same joystick.
The spawn-in locations are either in the field called “FB,” or in a city, called “AB.” What is
available depends on how active the location is and on your rank (most units are available
at Corporal level). From then on it’s drive, fly, boat, or just plain walk to the action. Of
course, you can hitch a ride or be towed by a truck by getting close and jumping on
board. While hundreds can be online, there is a limit of 64 for each FB or AB.
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The availability of equipment is a deciding factor in most battles. Scoring is based on two
factors in defensive missions: how much longer than 10 minutes they last and whether
you survive, and (in an attack mission) claiming a kill. This is much easier said then done,
as most of the time you are unsuccessful.

RAF out in force, Hurricanes and Blenhimes.

Of all the online games I have played this is the most reliable, even over a 56K modem.
Lag, when it happens, has almost no impact on ground operations, at most causing
movement jerkiness or a rare delay in updates on flags. I was able to test it simultaneously
by operating a tank, using two accounts over a high bandwidth connection. There was a
consistent 1/4–1/3 second feedback lag between the two, which is very good.
Considering that the servers need to keep track of hundreds of objects, including bullets,
test for collisions, and then inform each player’s computer of movement, hits, or other
events, one can begin to come to terms with the quality of this simulation.
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A successful hit does take about one second to register on your screen. In that time, a
signal of a hit is sent to the server, which passes that information to the opponents’
computers. They acknowledge the hit and report damage sustained; this information is
passed back to the server, and notice is finally sent back to the shooting players computer,
all in the space of that one second. A slow computer with a low frame rate suffers more
misses than lag.

Teamwork
The hallmark of this game is cooperation. Two players can share a single vehicle, where
one is usually a driver or pilot and the other is a gunner or bomber. Not only can a large
gun be operated by two people, but to move it across great distances one needs the
assistance of a third player to operate a truck.
In a tank, the driver will select the tank available and request an additional crew member
who takes the turret position. It makes for easier spotting of enemies, which is vital for
victory, but communication between driver and gunner is tricky. It is easier to be a tail
gunner to an aircraft’s busy pilot.

ATPM 9.05

96

Review: World War 2 Online

The implementation of this feature is refined, functional, and one of the best aspects of
this game. A cross-platform communications software called TEAMSPEAK is being used to
great effect to help coordinate vehicle operation as well as squad organization.

German forces moving out.

Details, Details, Details
The key to a great game or movie is in the details. Once, I spawned into a fighter; while
grounded, engine off, I fired its guns to observe the light effects and sound. To my
amazement, I started moving backwards! I had not expected the developers to model the
recoil on fighter aircraft as they did so well on tanks and guns, but they obviously have, to
great effect.
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These are not cookie cutter objects in different skins; every vehicle is beautifully modeled
and behaves differently, as does the recoil of each weapon. So too are the vulnerabilities
of each vehicle. Each vehicle contains fuel, ammunition, oil, power, controls, and of course
the crew, so a penetrating round may only damage one or two systems, if indeed it hits
anything.
With tanks, a shell may penetrate and ricochet off something inside before hitting a vital
item. You can swim across rivers, but make sure you are well rested or you will risk
drowning. Running takes away from your stamina, but lying down quickly recovers your
breath. Damage is variable, from being stunned, to sustaining light wounds, to being
mortally wounded, to dying instantly. Did I mention how beautiful the details are?

An 88mm cannon fires at night.

Bugs and Lags
Sadly, no game is perfect. Yet.
A pitfall of the game bemoaned by many is being locked inside a vehicle. There is no
means of escape, even if it means losing the vehicle forever. There is every chance a vehicle
is rendered immobile but its occupants survive. Yet they can’t get out, and they can’t
spawn out of the environment, either.
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Occasionally damage is ineffectual, or not properly recorded. An aircraft can on rare
occasions take a huge number of direct hits and still fly home, if smoking profusely. Tanks
have survived a large number of hits and attacks by sappers. The lag time between
computers can also make what is a sure-fire hit to you a complete miss. Another source of
gripes is damaged targets spawning out early, where the target leaves before being
completely destroyed, robbing the victor of full credit for the kill.
The one aspect of the game I did find wanting are the buildings. Large buildings in cities
resemble giant boxes on a Hollywood stage set. This is an unavoidable shortcoming in my
opinion, as rendering more detailed buildings means more demands on the computer and
server. Regardless, there is for each building a ground level and external stairs to the top.
There are a few small buildings and churches with internal stairs, but the window frames
are annoyingly thick. I saw one building with no upstairs windows.
The bunkers and fortifications in the game are oddly inaccurate. These bunkers are key
positions in the game that must be captured; however as a strong defensive building they
are anything but that. They are often positioned next to other buildings, trees, or walls
that obstruct any defensive fire, and have large openings that offer a direct line of
incoming fire. The system is not 100% efficient; objects and walls do not stop all shells or
explosions so it is possible to be hit inside a bunker. Overall, bunkers seem to be a
hindrance and many players question their purpose.
This game suffers from occasional freezes and application crashes that occur more
frequently on modem connections. On a broadband connection, a crash or freeze may on
average occur with every 15th spawn-in, but I am usually finished playing before that
happens.
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I have read some reports of poor performance even with new, high-end Macs. There are a
few map bugs, mainly bases that cannot be captured and trees invisible from one side. Lag
is generally unnoticeable—unless you are flying, when that short pause may seem to last
forever—but other then that it runs very smoothly, considering the hundreds of players
online at once.

Going on a river cruise in a small Fairmile patrol boat.

Play Tips
Be patient! If you rush into combat you won’t last long. Learn how to operate as many
individual vehicles as possible before you rush off to battle. Learn to work in teams, as you
cannot capture a town alone. The more familiar you are with your vehicles and maps, the
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more successful you are. Truck runs and defense missions are the best route to more
promotion points, but remember to despawn at base after a run. You must play the game
for more than ten minutes and survive to receive those points.

The cliffs of Dinant.

Last Call
World War 2 Online Blitzkrieg must not be seen as an arcade-style game such as Quake,
Medal of Honor, or Unreal. It is a serious combat simulation that can be enjoyed if treated
as such, and gives a good historical perspective of what it was like 63 years ago. This
game is most recommended for WW2 hobbyists, serious gamers, and those who like
simulation games, but it may still be attractive to arcade gamers.
The camaraderie you will find between players is very noticeable, with players trading
humorous war stories or boasts. Perhaps some will be perfectly happy just to drive to a hill
top, admire the virtual countryside, and listen to the digital birds.
Copyright © 2003 Joe Kudrna, joek@wt.net. Reviewing in ATPM is open to anyone. If you’re
interested, write to us at reviews@atpm.com.
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FAQ: Frequently Asked Questions
What Is ATPM?
About This Particular Macintosh (ATPM) is, among other things, a monthly Internet
magazine or “e-zine.” ATPM was created to celebrate the personal computing
experience. For us this means the most personal of all personal computers—the Apple
Macintosh. About This Particular Macintosh is intended to be about your Macintosh, our
Macintoshes, and the creative, personal ideas and experiences of everyone who uses a
Mac. We hope that we will continue to be faithful to our mission.

Are You Looking for New Staff Members?
We currently need several Contributing Editors. Please contact us if you’re interested.

How Can I Subscribe to ATPM?
Visit the subscriptions page.

Which Format Is Best for Me?
The Online Webzine edition is for people who want to view ATPM in their Web
browser, while connected to the Internet. It provides sharp text, lots of navigation
options, and live links to ATPM back issues and other Web pages. You can use
Sherlock to search all of the online issues at once.
The Offline Webzine is a HTML version of ATPM that is formatted for viewing
offline and made available in a StuffIt archive to reduce file size. The graphics,
content, and navigation elements are the same as with the Online Webzine, but
you can view it without being connected to the Internet. It requires a Web browser.
The Print PDF edition is saved in Adobe Acrobat format. It has a two-column
layout with smaller text and higher-resolution graphics that are optimized for
printing. It may be viewed online in a browser, or downloaded and viewed in
Adobe’s free Acrobat Reader on Macintosh or Windows. PDFs may be magnified to any
size and searched with ease.
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The Screen PDF edition is also saved in Adobe Acrobat format. It’s a one-column
layout with larger text that’s optimized for reading on-screen. It may be viewed
online in a browser, or downloaded and viewed in Adobe’s free Acrobat Reader on
Macintosh or Windows. PDFs may be magnified to any size and searched with ease.

What Are Some Tips for Viewing PDFs?
• You can download Adobe Acrobat Reader for free. If you have a Power Macintosh,
Acrobat Reader 5 has better quality and performance. ATPM is also compatible with
Acrobat Reader 3, for those with 680x0 Macs.
• You can zoom the PDF to full window width and scroll through articles simply by
single-clicking anywhere in the article text (except underlined links).
• You can quickly navigate between articles using the bookmarks pane at the left of
the main viewing window.
• For best results on small screens, be sure to hide the bookmarks pane; that way you’ll
be able to see the entire page width at 100%.
• Try turning Font Smoothing on and off in Acrobat Reader’s preferences to see which
setting you prefer.
• All blue-underlined links are clickable.
• You can hold down option while hovering over a link to see where it will lead.
• For best results, turn off Acrobat’s “Fit to Page” option before printing.

Why Are Some Links Double-Underlined?
In the PDF editions of ATPM, links that are double-underlined lead to other pages in the
same PDF. Links that are single-underlined will open in your Web browser.

What If I Get Errors Decoding ATPM?
ATPM and MacFixIt readers have reported problems decoding MacBinary files using early
versions of StuffIt Expander 5.x. If you encounter problems decoding ATPM, we
recommend upgrading to StuffIt Expander 5.1.4 or later.

How Can I Submit Cover Art?
We enjoy the opportunity to display new, original cover art every month. We’re also very
proud of the people who have come forward to offer us cover art for each issue. If you’re
a Macintosh artist and interested in preparing a cover for ATPM, please e-mail us. The way
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the process works is pretty simple. As soon as we have a topic or theme for the upcoming
issue we let you know about it. Then, it’s up to you. We do not pay for cover art but we
are an international publication with a broad readership and we give appropriate credit
alongside your work. There’s space for an e-mail address and a Web page URL, too. Write
to editor@atpm.com for more information.

How Can I Send a Letter to the Editor?
Got a comment about an article that you read in ATPM? Is there something you’d like us
to write about in a future issue? We’d love to hear from you. Send your e-mail to
editor@atpm.com. We often publish the e-mail that comes our way.

Do You Answer Technical Support Questions?
Of course. E-mail our Help Department at help@atpm.com.

How Can I Contribute to ATPM?
There are several sections of ATPM to which readers frequently contribute:
Segments: Slices from the Macintosh Life

This is one of our most successful spaces and one of our favorite places. We think of it as
kind of the ATPM “guest room.” This is where we will publish that sentimental Macintosh
story that you promised yourself you would one day write. It’s that special place in ATPM
that’s specifically designated for your stories. We’d really like to hear from you. Several
Segments contributors have gone on to become ATPM columnists. Send your stuff to
editor@atpm.com.
Hardware and Software Reviews

ATPM publishes hardware and software reviews. However, we do things in a rather
unique way. Techno-jargon can be useful to engineers but is not always a help to most
Mac users. We like reviews that inform our readers about how a particular piece of
hardware or software will help their Macintosh lives. We want them to know what works,
how it may help them in their work, and how enthusiastic they are about recommending
it to others. If you have a new piece of hardware or software that you’d like to review,
contact our reviews editor at reviews@atpm.com for more information.
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Shareware Reviews

Most of us have been there; we find that special piece of shareware that significantly
improves the quality our Macintosh life and we wonder why the entire world hasn’t heard
about it. Now here’s the chance to tell them! Simply let us know by writing up a short
review for our shareware section. Send your reviews to reviews@atpm.com.

Which Products Have You Reviewed?
Check our reviews index for the complete list.

What is Your Rating Scale?
ATPM uses the following ratings (in order from best to worst): Excellent, Very Nice, Good,
Okay, Rotten.

Will You Review My Product?
If you or your company has a product that you’d like to see reviewed, send a copy our
way. We’re always looking for interesting pieces of software to try out. Contact
reviews@atpm.com for shipping information. You can send press releases to
news@atpm.com.

Can I Sponsor ATPM?
About This Particular Macintosh is free, and we intend to keep it this way. Our editors and
staff are volunteers with “real” jobs who believe in the Macintosh way of computing. We
don’t make a profit, nor do we plan to. As such, we rely on advertisers to help us pay for
our Web site and other expenses. Please consider supporting ATPM by advertising in our
issues and on our web site. Contact advertise@atpm.com for more information.

Where Can I Find Back Issues of ATPM?
Back issues of ATPM, dating since April 1995, are available in DOCMaker stand-alone
format. In addition, all issues since ATPM 2.05 (May 1996) are available in HTML format.
You can search all of our back issues.
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What If My Question Isn’t Answered Above?
We hope by now that you’ve found what you’re looking for (We can’t imagine there’s
something else about ATPM that you’d like to know.). But just in case you’ve read this far
(We appreciate your tenacity.) and still haven’t found that little piece of information about
ATPM that you came here to find, please feel free to e-mail us at (You guessed it.)
editor@atpm.com.
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